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Advanced User Guide Overview 

Purpose 

The purpose of the advanced user guide is to provide a detailed overview of the STARS tool and provide step-by-step 

instructions on the functionality of STARS. The user guide includes detailed explanations, best practices, and guided 

exercises to facilitate STARS training and adoption.  

Table of Contents 

The advanced user guide is broken into ten different sections, each consisting of specific functionality available in the 

STARS program. Each of these sections contains subsections that are listed with corresponding page numbers on the 

Table of Contents.  

Note: The Table of Contents contains clickable links on each section and subsection to allow the user to access 

the section directly without having to manually navigate to the corresponding page number. 

Navigation 

Each of ten sections includes topic overviews and guided exercises. 

Each section and subsection begins with an overview of the topic that will be covered as well as tables and screenshots 

detailing the different layouts, icons, and items the user will interact with in the section. 

Each section will also include guided exercises with enumerated steps and corresponding screenshots for the user to 

follow and gain hands-on experience on the topic covered. Each guided exercise will be marked within the user guide by 

the presence of a blue “Guided Exercise” text box as shown in the screenshot below. The user should start the guided 

exercise beginning with the first numbered step below the blue “Guided Exercise” text box. 

Example: 

 

  

 

 

 

 

 

 

The Advanced User Guide begins with the Table of Contents and the Course Introduction. 
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1. Course Introduction 

 
Purpose This course introduces participants to the State Analytical Reporting System (STARS) 

using the OBI platform. This application focuses on using the Analysis and 
Dashboards interface. Participants will also learn how to use help functionality 
specific to the OBI application. 
This course will instruct participants on how to create and execute analyses. 
Additionally, participants will learn how to manage, manipulate, format, and save 
analyses in order to obtain the desired information and display it on Dashboards 

Getting Started In this section, the following topics are covered: 

 Participant introductions  

 Course Objectives and materials (classroom guide, job aids, files) 

Audience This course is designed for State Analytical Reporting System (STARS) Analysis and 
Dashboard users. 

 The following topics will be discussed during this course: 

 Course Introduction 

 Navigate OBI - STARS 

 Create and Save Analyses 

 Format Analysis & Columns 

 Customize Analysis Views 

 Drill Down Functionality 

 Search Analysis & Print or Export Results 

 Work with Dashboard Prompt 

 Build & Design Dashboard 
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Course Objectives The following processes and objectives will be covered in this course: 

 Process  Objectives 

  Overview of Analyses  View an Analysis and Dashboard 

  Navigate OBI – STARS Sign into OBI - STARS 
Understand OBI Home page 
Understand the Analysis Editor Criteria tab 
Understand Filter Editor 
Understand the Analysis Results tab 
Understand Analysis Views Editor 

  Create and Save Analyses Create a New Analysis 
Guided Exercise 
Saving Filters from Analysis 
Applying Saved Filters 
Move and Delete an Analysis 

  Formatting Analysis & 
Columns 
  

Move, Add, Exclude, Hide & Delete Column 
Sorting a Column 
Adding Grand Totals & Sub Totals 
Edit Column Format 
Edit Value Format 
Edit Data Format 
Apply Conditional Formats 

  Customize Analysis Views Type of Views 
Table Properties 
Add a Pivot Table 
Adding a Graph 
Formatting Graph 
Editing Graph Properties 
Adding Pivot Table Graph 
Adding a View Selector 
Adding a Column Selector 
Delete Views  

 Drill Down Functionality Creating another Analysis 
Navigating Action Link 
Creating Action Link 
Testing Action Link 

  Print and Export Results Search for an Analysis 
Print Results to PDF 
Export Results to Excel 

  Work with Dashboard 
Prompts 

Understanding a Dashboard Prompt 
Creating Dashboard Prompt 

  Building & Designing 
Dashboard 

Understanding & Navigating My Dashboard 
Building My Dashboard 
Editing My Dashboard 
Saving a Dashboard Customization 
Setting Preference 
Exporting the Dashboard to Excel Spreadsheet 
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2. Navigate OBI - STARS 
 

Introduction Typically, organizations track and store large amounts of data about products, customers, 
contacts, activities, employees, and other elements. This data is often spread across multiple 
databases in different locations with different versions of database software.  
After the data has been organized and analyzed, it can provide an organization with metrics to 
measure the state of its business. This data can also present key indicators of change in market 
trends and in employee, customer, and partner behavior. OBI helps you obtain, view, and 
analyze data. 
Analysis provide “answers” to business question, allowing you to explore and interact with 
information, as well as present and visualize data using graphs, pivot tables, and analyses. You 
can save, organize, and share these results with others. 
Analyses that you create with the Analysis Editor can be saved in the Presentation Catalog and 
integrated into the OBI dashboard. Results can be enhanced through graphing, view layout, 
calculation, and drilldown features. 
Security and data access for OBI is controlled at the data level, not the application level.  
Follow the steps below to access the Analysis Editor. 

Objectives At the end of this section, you will be able to complete the following tasks related to Analysis 
Navigation. 

 Sign into OBI - STARS 

 Understand OBI Homepage 

 Understand the Analysis Editor Criteria tab 

 Understand Filter Editor 

 Understand the Analysis Results tab 

 Understand Analysis View Editor 
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2.1 Sign into OBI - STARS 
 

Typically, organizations track and store large amounts of data about products, customers, contacts, activities, employees, 
and other elements. This data is often spread across multiple databases in different locations with different versions of 
database software.  

 
After the data has been organized and analyzed, it can provide an organization with metrics to measure the state of its 
business. This data can also present key indicators of change in market trends and in employee, customer, and partner 
behavior. OBI helps you obtain, view, and analyze data. 

 
Analysis provide “answers” to business question, allowing you to explore and interact with information, as well as present 
and visualize data using graphs, pivot tables, and analyses. You can save, organize, and share these results with others. 

 
Analyses that you create with the Analysis Editor can be saved in the Presentation Catalog and integrated into the OBI 
dashboard. Results can be enhanced through graphing, view layout, calculation, and drilldown features. 

 
Security and data access for OBI is controlled at the data level, not the application level.  
Follow the steps below to access the Analysis Editor. 

 

 
 

 

 
 

Exercise Steps 

1. Open Internet Explorer and enter the URL: - https://stars.ct.gov/ for the environment in the 
Address field. 

         Note: The OBI login window displays. 

2.    Enter your User ID and Password in the appropriate fields 

3.    Click. 
         Note: The application launches and displays the Analysis Editor Home page 

 

https://stars.ct.gov/
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2.2 Understand OBI Homepage 
 

 
 

Introduction The Home page provides an intuitive, task-based entryway into the functionalities of OBI. 
The Home page is divided into sections that allow you to quickly begin a specific task, 
locate, or create a new object, or access technical documentation. 

1. Create The Create section allows you access to editors for OBI objects to create OBI content, 
including analyses, agents, Key Performance Indicators, and analyses. 

2. Browse/Manage  In the Browse/Manage section, you can search content using the Catalog page by clicking 
the All Content link or apply default searches that return OBI objects that belong to you 
using the My Analysis, My Agents, and other similar links. 

3. Get Started In the Get Started section, you can access download links for OBI desktop tools, for 
example, the OBI Office Add-In, as well as access technical documentation and other 
related content. 

4. Recent/Most 
Popular 

The Recent and Most Popular sections contain recently opened objects, and those that 
are most popular among you and other users of the system. 

5. Global Header You use this section to access links and options to begin a task or locate an object. 

6. Search You use this option to search for an object from the global header. You can search for an 
object by its name, location, or type only, which is similar to using a Find dialog box in 
many products. You will find only those objects for which you have the appropriate 
permissions. When the desired object is located, you can click it to display it for viewing 
or editing, as your permissions allow. 

7. Help button 

 

You use this link to display the following options: 
BIEE Home Help dynamically changes to display the Help topic for the current page, 
editor, or tab. 
Help Contents displays a cascading menu that provides options that link to the tables of 
contents for OBI, BI Publisher, and Marketing. 
Documentation displays the documentation library for OBI. 
OTN… displays the Business Intelligence and Data Warehousing Technology Center page 
on the Oracle Technology Network (OTN). 
About OBI displays a dialog identifying the OBI version and copyright information. 

8. Sign Out link 

 

You use this link to log out of the OBI application. 
Note: Do not close the browser window to exit from OBI. 

9. Home link 

 

You use this link to navigate to the Home page from any other part of the user interface. 
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10. Catalog link 

 

You use this link to navigate to the Catalog page, in which you can navigate and work with 
objects in the Presentation Catalog. 

11. Dashboards link 

 

You use this link to access the customized Dashboards and My Dashboard, used to display 
analyses created in Analysis Editor. 

12. New link 

 

You use this link to display a list of the objects that you can create. To create an object, 
select it from the list. The appropriate dialog or editor displays for you to create the 
object. 
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2.3 Understand the Analysis Editor Criteria tab 
  

Note: The Analysis Editor view below is explained in detail in the Introduction course. To get to the Analysis editor view, navigate to New > 
then click Analysis from the Home page. Next specify the Subject Area you would be working on it. 

 
The Analysis Editor is divided into three Components. 

 
a. Main Components 
b. Common Components 
c. General Components 

 

 
 

The Analysis Editor is composed of tabs and panes, as shown in the screen shot, representing the subject area (columns), 
available catalog objects, selected columns for the analysis, and filters (which limit the selected data). 

 

Exercise Steps 

Review the following components on Analysis Editor Page.  

Element Description 

Main Components: 

1. Criteria It is used to specify the criteria for an analysis, including columns and filters. 

2. Results It is used to create different views of the analysis results such as graphs, tickers, 
and pivot tables. 

3. Prompts Prompts tab to access the "Prompt editor" to create prompts that allow users to 
select values that dynamically filter all views within the analysis or all analyses on a 
dashboard. 

4. Advanced It is used to examine or edit the XML code and logical SQL statement that is 
generated for an analysis. 

5. Save  
Use this button to save an analysis. 

6. Save As  
Use this button to save an analysis as another name. 

Common Components: 

7. Subject Areas In this section we select the columns and hierarchy levels for an analysis and to 
work with subject areas. 
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There are three column types in a subject area. They are 

Attribute 
Column 

Presentation Columns are renamed as Attribute Columns. In OBI 
they are also called as Dimension Columns. Example:- 
Department (as shown in below fig) 

Measure 
Column 

It holds a simple list of data of values. It is a column in an OBI 
repository, usually in a Fact Table. Example Age(Years) (shown in 
below fig) 

Hierarchy 
Column 

Holds a list in which individual members are shown in an outline 
manner, with lower-level members rolling into higher-level 
members, and outline totals being shown for the higher-level 
members. Example: - Not shown here. 

 

8. Catalog This section is used to drag and drop objects from the catalog to add to the 
analysis like saved filters. 

General Components: 

9. Selected Columns In this pane we used to modify the columns and hierarchy levels that have been 
selected for an analysis. 

10. Filters It is used to create new filters for an analysis. 
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2.4 Understand Filter Editor 
 

Review the following components on Filter Editor. 

 

 

Element Description 

Main Components: 

1. Column It shows the name of the column on which filter is being created. The name of the 

column can be changed by click on Edit icon .  
It will open Edit Column Formula dialog box where you can change or select any 
column from the Subject Area section by expanding folders Worker > then 
Employment. 

 
2. Operator In the operator drop-down menu, it will display all type of different operators as 

shown below: 
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3. Value Enter value to restrict the data by selecting one or more values by click on drop 

down menu.  

 
 

Advanced Search:- Click on Search icon  to filter out  

 
 

Once you click on Search icon a dialog opens. This box will help us in filter out the 
number of values to a small no, so that it makes easy to select values. 

 
4. Add More Options This feature is used when we have to use Variables like session, repository and 

Presentation. 

 
5. Clear All 

It will clear all the values selected in Value box.  

6. Protect Filter Enabling this filter will basically “hard-codes” a filter so that it won’t be 
overwritten. 
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7. Convert this filter to 

SQL 
Enabling this feature will allow you to write logical SQL for the where clause in the 
query we will have to use the filtering option over the selection steps because 
we’re able to convert filters into SQL which we can customize or we can add a SQL 
statement straight to the filter without converting it. Once you convert a filter to 
SQL you will not be able to revert it back to the original dialog box and will only be 
able to edit it in the Advanced SQL Filter box. A powerful feature of the filters is 
that it allows you to write SQL statements and that will affect the where clause of 
an analysis. This allows you to potentially write more complex statements for your 
filtering needs. 

 
Once you select “Convert this filter to SQL” the next box will allow you to write 
your own SQL code for the filter, if there are more options selected before you 
convert your  SQL, it will convert that as well. 
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2.5 Understand the Analysis Results tab 
 

Elements Description 

Print this analysis  You use this button to print in PDF or HTML formats. 

Export this analysis  You use this button to export analysis or data in different formats. 

Show how results will look on a 

Dashboard  

You use this button to preview the current view. 

Print Options  You use this button to specify areas for printing. 

Refresh the results of the current 

analysis  

You use this button to refresh the results of the current analysis Deletes the 
view 
Caution: There is no confirmation. 

New View  You use this button to display a list of views from which you can select the 
view that you want to create. The view is added to the current compound 
layout. 

New Group   You use this button to add a group. 

New Calculated Item  You use this button to build calculated items. 

Edit Analysis Properties  You use this button to specify properties for the entire analysis. 

Import formatting from another 

analysis  

You use this button to select an analysis from which to import formatting for 
columns and views. 

Create Compound Layout  You use this button to create a new instance of the compound layout. 

Duplicate Compound Layout  You use this button to create a copy of the current compound layout. When 
you copy, you do not actually create additional copies of the analysis or its 
views. The analysis and views exist only once. Any changes that you make to 
the analysis or its views are reflected in the multiple instances of the 
compound layout. 

Delete Compound Layout  You use this button to delete the current compound layout. The views in the 
layout are not deleted from the analysis. This button is not available if you 
attempt to delete the last compound layout in the analysis. 

Rename the Analysis  You use this to rename the analysis 

Show/Hide Selection Steps pane 

 

You use this button to show or hide the display of the Selection Steps pane 
in the Results tab. 

Save Analysis button  You use this button to save an analysis to a folder. 

Save As button  You use this button to save an existing analysis as another name. 

Help  You use this button to open the first level of help documentation for the 
Analysis Editor 
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2.6 Understand Analysis Views Editor 

  
 We can change the layouts of views by editing the views through View Editor. 

 
Below explained with sample analysis 

  

 
 
 

Pane Description 

1. Preview Pane In this pane we can preview the results based on Layout Pane. 

2. Layout Pane In this pane we can change the structure of the report by moving 
columns, adding subtotals and grand totals, by changing the format 
of the table values and column headings. 

3. Done Once the changes are made. Click Done to go to Compound Layout. 

4. Revert If you want to go back to initally layout structure or format then click 
Revert. 
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3. Create and Save Analysis 
 

Introduction The Analysis Editor interface is part of the State Analytical Reporting System (STARS) 
application used to query information across all the different agencies within the State of CT 
system. The Analysis Editor function allows you to explore and interact with information, and 
present and visualize information using drillable tables, graphs, pivot tables, and other 
reporting formats. You can save, organize, and share the results through Dashboards, alerts, 
or exporting to another format. 
Analyses are user-defined reports that pull data from a consolidated data warehouse. 
Analyses that you create with the Analysis Editor can be saved in the OBI Presentation 
Catalog and integrated into a dashboard. Results can be enhanced through graphing, 
compound layout, calculation, and drilldown features. 
Analyses can be tailored and altered to meet the needs of each individual user. Analyses 
created in the Analysis Editor must be saved in order to use and display on Dashboards. You 
can save analyses to private folders for quick execution and modification. You can also save 
analyses to a common shared folder to grant other users access to analyses that you create. 
In this module, you will learn how to save analyses and modify previously saved analyses. 

Objectives At the end of this section, you will be able to complete the following tasks related to Analysis. 

 Create a New Analysis 

 Guided Exercise 

 Save Filters from Analysis 

 Apply Saved Filters 

 Move or Delete an Analysis 
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3.1 Create a New Analysis 
 

The Analysis Editor interface allows you to make analytical analyses based on data that is stored in the data warehouse. You 
can select specific tables and columns that are stored within the data warehouse to execute a specific analytical analysis. 

 
To access the analysis editor view, follow the steps below: 

 
1. From the home page, Click New > then Analysis. 

 

 
 

2. Then Select Subject Area pop-up appears. Then select Procurement and Spend – Purchase Orders. 
 

 
 

3. The Analysis Editor will be displayed. 
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In this exercise we will be creating Count of PO’s by Item ID analysis so we can view the number of PO’s for a specific Item 
in a particular time period. 
The columns and Filters that we will use in this report are as follows: 
 

Columns:- 

Folder Columns 

Purchase Order Details  ->  Purchase Line 1. PO Line Item ID 
2. Item Description 

Purchase Order Details 3. PO ID 

Purchase Order Details -> Purchase Schedule 4. PO Schedule PO Price 
5. PO Schedule PO Price 

 
Filters:-  

Column Operator Value 

Accounting Year Is equal to / is in 2016 

PO Business Unit Is equal to / is in DOTM1 

PO Line Item ID Begins with CM_ 

 
1. Make sure the Criteria tab is selected.  

Now, we will drag and drop or double click the following columns form the Subject Areas pane into Selected 
Columns pane as shown in the screenshot below. 

 
2. Navigate to the Purchase Order Details -> Purchase Line and expand it. Drag and drop the PO Line Item ID, Item 

Description columns into the Selected Columns pane as shown in the screenshot below: 
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3. Navigate to the Purchase Order Details folder and expand it. Drag and drop the PO ID column into the Selected 
Columns pane as shown in the screenshot below: 

 

 
 

4. In similar way Navigate to the Purchase Order Details > then Purchase Schedule folder and expand it. Drag and 
drop the PO Schedule PO Price column two times into the Selected Columns pane as shown in the screenshot 
below: 

 
 

Note:- In the Selected Columns section, you can reorder the columns in your analysis by clicking and dragging them.  
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5. Hover over the edge of PO Schedule PO Price Column to display more drop down menu, click on edit formula. 
 

 
 
Edit Column Formula dialoge box opens:- 
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Ensure all text in the Column Formula is selected. And then click on f(…) as show in the below 
screenshot. 
 

 
 
F(…) buton opens an Insert Function pop-up window 
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Expand Aggregate Function and select Max. Click OK to close the window. 
 

 
 

 
The formula inside Column Formula should now read as MAX("Purchase Schedule"."PO Schedule PO Price"). 
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Click Custom Heading check box and type Max Price in Column Heading as shown below then click OK to 
close the Column Formula dialog box. 
 

 
 
 
PO Schedule PO Price should now appear as shown in the below screenshot. 
 

 
 
 

6. Hover over the edge of PO Schedule PO Price last Column to display more drop down menu, click on edit 
formula . 
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Ensure all text in the Column Formula is selected. And then click on f(…) as show in the below 
screenshot. 
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F(…) buton opens an Insert Function pop-up window 
 

 
 

Expand Aggregate Function and select Max. Click OK to close the window. 
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The formula inside Column Formula should now read as MIN("Purchase Schedule"."PO Schedule PO Price"). 

 

 
 
Click Custom Heading check box and type Min Price in Column Heading as shown below then click OK to 
close the Column Formula dialog box. 
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The columns in selected columns should appear as shown in below screenshot. 
 

 
 

7. In the similar way edit PO ID column to create Count of PO’s as shown in the below screen: 
 
Note:- Be sure to add: COUNT(DISTINCT..........) keyword as shown below. 

 

 
 

 
 

8. Hover over the edge of the PO Line Item ID column to display the More drop down menu to create a Filter. Click 
over the columns toolbar by selecting the More drop-down menu. 
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   Editor dialog opens, 
 

 
 

9. Set the operator to value “begins with”.  
 

 
 

10. Click on Value field and enter CM_ 
 

 
Click OK. 
 
 
 
 

11. Filter pane displays the newly created filter. 
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Next, let’s add Business Unit filter. 
Since PO Business Unit column is not available selected columns, we have to create this from Filter Pane. 

 

12. Go to "Create a filter for the current Subject Area" icon in Filter pane, and then click on More Columns. 
 

 
 

A subject area dialog opens, expand Business Unit to select PO Business Unit. 
 

 
13. Set the Operator as default value. And select Business Unit value as “DOTM1”. Click OK. 
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The filter pane now will look as below:-  
 

 
 

14. Repeat the same steps for the following column filters. 
 

Folder > Column Operator Value 

Accounting Date > Accounting Year  Is equal to / is in 2016 
 

Once all the filters are applied, the filter pane will look as below:- 
 

 
 

15. Click Results tab to view the data. 
 

 
 

Note: Notice how the default views in the results are Title view and Table view 

 
Save Analysis to a Personal Folder 

 

Next we will save the Analysis in the web catalog, so that the analysis can be accessible whenever needed. 
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1. To do so, click the Save icon  to save your analysis. 
 

2. Save as dialog displays, navigate to My Folders in the left hand pane and then click the New Folder icon. The 
New Folder dialog box appears. 

 
3. Name the folder as Training and click OK. 

 

 
 

4. Name the analysis as Count of PO’s by Item ID and click OK. 
 

 
 

   Note: Now the analysis will be saved under My Folders/Training in the Web Catalog. 
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3.2 Save Filters from Analysis 
 

Users may find it useful to save complicated filters that could apply to many different queries, so that you don’t have to 
keep recreating them. 

 
 To save filter from analysis, follow the below steps: 
 

1. Navigate to My Folders/Training folder and select Count of PO’s by Item ID. Click Edit. 
 

 
  
2. Click on Criteria Tab of the Analysis. 

 

 
 

3. Click the More Options icon in the filters pane and select Save Filters from the drop-down list. 
 

 
 

The Save As dialog box should look like this: 
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Note: A filter must be saved to a subject area folder so that it is available when you create an analysis using the same 
subject area. 
 

4. Name the filter Count of PO’s by Item filter and accept the default location which is “My Folders/Subject Area 
Contents/Procurement and Spend – Purchase Orders” 

 

 
 
 

Note: OBI allows you to save any type of business intelligence object to any location within the Catalog. However, for some 
object types such as filters, OBI suggests the best Catalog location. 

Click OK. 
 

5. The filters pane appears as follows with the saved filter name 
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Note: Don’t save the analysis. 
 

6. Navigate to Catalog and go to My Folder to check the filter which we just saved. It should be under the 
following path:- 
/My Folders/Subject Area Contents/ Procurement and Spend – Purchase Orders 
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3.3 Apply Saved Filters 
 

We can apply saved filters to the analysis if we need to reuse the filters we have created in other analysis, this way we will 
save time and effort when creating new analyses. 

 

 

To show how to apply a saved filter, we will delete the Filter from an Analysis and apply the Filter we just saved in 
Section 3.2. 
 
1. Navigate to My Folders/Training and select Count of PO’s by Item ID then click “Edit”. 
 

 
 

2. Select the Criteria tab. 
 

 
 

3. Click on “Remove all Filters” from the Filters pane. 
 

 
 
 
 
 
 
 
 

4. Filters will be deleted and filter pane will appear as shown below: 
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5. Go to Catalog section under Subject Areas then go My Folders/Subject Area Contents/Procurement and Spend 

– Purchase Orders to select Count of PO’s by Item Filter. 
 

 
 

6. Click on the green plus sign and blue arrow (step # No. 6 above) to move that filter to the Filters pane. 
 

7. Apply Save Filter dialog opens:- 
 

 
 

Elements Description 

1. Filter Location It will show the path where this filter is saved. 

2. Contents of Filter It will display all the conditions used in the saved filter. 

3. Filter Options a. Clear all existing filters before applying: It will clear all the filters which are being 
used in the current analysis and will apply this saved filter. 
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b. Apply contents of filter instead of a reference to the filter:- It will display all the 
condition instead of filter name in the filter pane. 

 
8. Leave the default values and click OK. 

 

 
 

Note: Hover over the saved filter to click on  and the saved filter conditions. 

 
 

Thus the saved filter will be applied when we click on Results.  
Note: - Don’t save the report, as this is an example for the class. 
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3.4 Move or Delete Analysis 
 
NOTE: The Copy feature is covered in section 6.1 

 

An Analysis can be moved from one folder to another folder as needed. The following are the steps for it. 
 

We will create a new folder under “My Folders” and name it as “Temp” in the following way:- 
 

 

1. Click catalog from Global header. 
 

 
 

2. Select “My Folders” and then click New to select “Folder” 
 

 
 

3. A new dialog opens, name it as Temp and click OK. 
 

 
 

A Folder gets created under My Folders. 
  

Next, we will move Count of PO’s by Item from Training Folder to Temp Folder. 
 

4. Go to Training folder and select Count of PO’s by Item. Click and hold to drag and drop the analysis in Temp 
folder as shown below. 
 

 
 

Now the Analysis will be moved from Training Folder to Temp folder 
5. Navigate to My Folders/Temp to check the analysis which we just moved. 
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Deleting an Analysis   
   

Note: We won’t be deleting the analysis.  

 
6. To Delete the Analysis, click on More drop down menu for Count of Pos by Item ID to select Delete option. 

 

 
  

7. Do not actually delete the analysis. Click  cancel to cancel the Delete function.  
 

 
  

Note: It will premanently delete that analysis from the Folder. 

 
8. Now move back the analysis to Training Folder. 
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4. Format Analysis & Columns 
 

Introduction After you run an analysis, the results are formatted using default formatting rules. By 

adding additional formatting to the results, you can draw focus to blocks of related 

information and call attention to specific data elements. 

You can edit properties for a column to control the appearance and layout of a column and 

its contents. You can also specify formatting to apply only if the contents of the column 

meet certain conditions. By default, your selections for a column apply only to the current 

analysis. 

You can create or modify the formula or aggregation rule behind a column through use of 
the formula function within the Analysis Editor. This modification is completed in the user 
interface for an individual analysis; it does not affect the column rule for other analyses. 
This functionality requires a basic knowledge of SQL syntax and expression writing. 

Objectives At the end of this section, you will be able to complete the following tasks related to 
results on Analyses tab. 

 Move, Add, Exclude, Hide/Delete Column 

 Sort a Column 

 Add Grand Totals & Subtotals 

 Edit Column Format 

 Edit Value Format 

 Edit Data Format 

 Apply Conditional Format 
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4.1 Move, Add, Exclude, Hide & Delete Column 
 

Move a column 
 
In the Compound Layout under Results tab, we have the ability to change the presentation of data based on the desired 
outcome.  
By default the results tab of the analysis is grouped based on what has been selected first in the Criteria tab when we first 
created the analysis. This can be changed by moving or reorganizing the columns displayed in the report by following the 
below steps.  

 
Edit the “Count of PO’s by Item ID” analysis under My Folders/Training and select the Results tab as shown below. 
 

 
 

 

a. By Dragging:-  
 

1. Hover over the column header of Min Price, cursor will change to drag symbol then left click and drag and drop 
it before Max Price 
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  The above screenshot is final display of our results. 
 

 

b. By Run time Option:-  
 

2. Hover over the column header of Min Price and right click to get run time options (aka drop down options) 
Click on Move Column drop – drop menu. 
 

 
 

  Elements Description 

1. Move Column This option in Run time Menu allows you to move column to Left, 
Right, To Prompts, and To Sections & To Columns. 

2. Right It will move column to Right 

3. Left It will move column to Left 

4. To Prompts It will move the column to Table Prompt level and restrict the data 
by select values. 

5. To Sections It will divide the results into sections based on column selected. 

6. To Columns It will move the column back to Tables. 

 
3. Now, move the Min Price column to Right. Hover over the column header of the Min Price column and right 

click to get run time options (aka drop down options). Highlight the Move Column then select Right. 
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   This will move the column to right as shown below: 
 

 
 
 
 
 
 
 
 
 
 

4. Now move PO Line Item ID column to Table Prompts by clicking on To Prompts. To do so,  Hover over the 
column header of the PO Line Item ID column and right click to get run time options (aka drop down options). 
Select Move Column and then click on To Prompts. 
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Note: To move back Table prompt  to Table, click on To Columns. 
 

 
 
 
 
 
 
 
 
 
 
 

   

c. By Edit View:- 
 

5. To move or reorder of columns to your analysis, click the Edit View icon in the Table View. 
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The Table Editor appears as shown. 
 

 
 

6. Under Layout Pane drag and drop the PO Line Item ID column into the Sections pane as shown below. 
 

 
 

Note: The column can also be moved to Table Prompts based on requirement. 

 
7. Check the results in Preview Pane. 
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Note:- In the Preview pane, we can see the results in sections. 

 
8. Drag the PO Line Item ID column back to Columns and Measure. 

 
Click Done.  

 

Add a column 
 

To Add Columns to your analysis can be done in the following way:- 
 

Make sure to Open the “Count of POs by Item ID” and select the Results tab by clicking on Edit as shown: 
 

 
 

 

a. Edit View: -  

1. To Add Columns from your analysis, click the Edit View  icon in the Table View.  
 
Next we will add Accounting Year to the results. 

 
2. Expand Accounting Date > Accounting Year to select Accounting Year from Subject Areas and drag & drop in 

Layout pane in Column & Measures section. 
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3. Click Done. 
 
 
 
 
 
 

Exclude a column 
 

To Exclude a Column there are two ways:-  
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Run time Menu 
Edit View 

 
Make sure to open the “Count of POs by Item ID” and select the Results tab by clicking on Edit as shown: 

 

 
 

 

a. Run time Menu:- 
 

1. On Results tab, go to Accounting Year column, right click on column header to view the run time menu. 
Click Exclude Column. 

 

 
 

2. It will not delete the column, it will just exclude the column. 
 

 
 

3. If you want to include the column, just go to any column and right click to get runtime menu.  
Click Include Column and then Accounting Year. 
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It will include the column. 
 

 
 

b. Edit View 
 

1. To Exclude column, Columns from your analysis, click the Edit View  icon in the Table View. 
  Go to Layout pane and Drag Location Code column and drop in Excluded as shown below. 

 

 
 

2. Check the Preview layout to see that column is excluded. 
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Note: It can be included by dragging and dropping in the Columns and Measures section. 

 

 
 

Click Done. 

Hide/Delete a column 
 

Hide a column:-  If you want to include a column but don’t want to display in the table, you can hide a column. Hiding a 
column doesn’t delete column from Criteria tab. 
Delete a column:- If you select an incorrect column or a column is no longer necessary for the analysis, you can remove the 
column from the analysis. You cannot delete the entire table; you must delete each column separately. It deletes column 
from Criteria tab. 
Deleting a column does not delete filters based on the column. The filter will still be active even if the data is not displayed 
in the results.  
 

Difference between Hide and Exclude Column: If you sort by columns then “hide” them then the table is sorted by the 

hidden columns. But if you sort by columns then “exclude” them then the table is no longer sorted by the excluded 
columns. So "hide" allows you to sort by a non-visible column. 
 

 Hide a column 
To hide a column, there are two ways:-  

o Run Time Menu 
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o Edit View 
Make sure to open the “Count of PO’s by Item ID” and select the Results tab by clicking on Edit as shown: 

 

 
 

 

a. Run Time Menu:- 
 

1. On Results tab, go to Accounting Year column, right click on column header to view the run time menu. 
2. Click Hide. 

 

 
 

Note:- From Runtime Menu we cannot display a hidden column. 

  
  
b. Edit View:- 

1. To Hide column from your analysis, click the Edit View  icon in the Table View. 
Go to Layout menu and you will see Accounting Year as unhighlighted as we have just Hide the column from 
Run time Menu. 
 

 
 

2. To unhide Click the More Options icon  for Accounting Year and click Hidden. 
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This will unhide the column. And again if you want to hide it, repeat the same by going to More Options. 
 

 
 

3. Click Done. 

 
Deleting a Column 
 

 

To Delete Columns from your analysis, click the Edit View  icon in the Table View. 

1.   In the layout pane, click the More Options icon  for Accounting Year and select Remove Column. 
 

 
 

 
2. Click OK when a box appears.  

 

 
 

Note: Check the Perview Layout to make sure that the column is deleted.  
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3. Click Done. 
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4.2 Sort a Column 
 

Column results can be sorted in ascending or descending order for an analysis. You can sort on multiple columns for an 
analysis. When sorting on multiple columns, the sort order is indicated by a number that displays in the lower left corner of 
the Order by button. 
 
Sorting columns can be done in the following ways: 
 
Make sure to open the “Count of PO’s by Item ID” and select the Criteria tab by clicking on Edit as shown: 

 

  
 

 

a. From Criteria Tab:- 
 

1. On the Criteria tab, click the More Options icon for PO Line Item ID. 
2. Select Sort > Sort Ascending. 

 

 
 

Observe that a sort icon is added to PO Line Item ID.  
 
Note: The order of the sort is indicated by an arrow, in this case the arrows point up, indicating that it is ascending. Additionally, 
if multiple sorts are added, a subscript number will also appear, indicating the sequence for the sort order. 

 
3. Added sorting for Count of PO’s as descending order. Now number will appear saying that it is sorting based on 

those numbers. 
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4. Click on Results tab to see the results. 
 

b. From Results Tab:- 

i. Hover the cursor over the PO Line Item ID column header to see two arrows displaying.  
Click on upside arrow for ascending. Once clicked that arrow will be highlighted. 

 

 
 

The results will also be sorted by PO Line Item ID. 
 

3. To add More sorting:- Go to Count of PO’s column header and right click so that a run time menu opens up. Go 
to Sort Column to click on Add Descending Sort. 
 

 
 

The results now will be sorted first by PO Line Item ID (ascending order) and then by Count of PO’s (Descending 
order). 

 
 

Note: Difference between Sort Ascending and Add Ascending Sort is that later adds sorting to the already existing 
sorting where as former just sort the result based on the selected column only. 

4.3 Add Grand Totals & Sub Totals 
 

You can display a sub-total for a numerical column based on specific criteria; this will total a subset of rows and create an 
additional row for the subtotal. You can total any number of Attribute columns; you cannot total Fact columns. However, 
you must have Fact columns in your analysis for the totals to work correctly. You can also analysis a grand total for a 
numerical column based on all returned records. You can also create a grand total for a numerical column based on all 
returned records. 

 

Note: If the totals are not correct, you may need to change the Aggregation rule from Default to Sum. Refer to the OBI Documentation for 
more information. 

 

When you activate the Total By function for a column, the analysis automatically sorts by that column in ascending order. 
All additional sort order functions occur after the initial sort. 
 

Make sure to open the “Count of PO’s by Item ID” and select the Results tab by clicking on Edit as shown: 
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Grand Total: 
 

1. In Results tab, click on Edit of Table View. 
 

 
 

2. Table View Editor will open. 
 

 
 

3. To add a Grand total to the analysis, click the Total icon to the right of Columns and Measures in the Layout 
pane of the Table editor. 
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4. Select After from the drop-down list. Review the results in the Preview pane, and note that the Total icon now 
displays a green checkmark, indicating that a grand total has been added to the analysis. 

 

 
 

Click Done. 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Sub Totals: 
 

1. To add a Sub Total by PO Line Item ID to your analysis, click the Edit View  icon in the Table view. The Table 
Editor appears. 

 
In the Layout pane, click the Total icon for PO Line Item ID. 
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2. Select After from the summation drop-down list. Review the results in the Preview pane, and note that 
the Total icon now displays a green checkmark, indicating that a total has been added for that specific PO Line 
Item ID. 

 
 

3. Click Done. 
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4.4 Edit Column Format 
 

After you create and run an analysis, default formatting rules are applied to the analysis results. You can create additional 
formatting to apply to specific results. Additional formats help you to highlight blocks of related information and call 
attention to specific data elements. You can also use additional formatting to customize the general appearance of analyses 
and dashboards. 
 

Navigate to My Folders/Training and select Count of PO’s by Item ID to click Edit. 

 
 

 
 

Next we will apply formatting to the PO Line Item ID column. 
 

 

1. To edit Column header of the analysis, click Edit View  icon on the Table view. 
 
2. Table View Editor will open. 
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3. You apply formatting to a heading. In Layout pane, click the More Options icon  for PO Line Item ID and 
select Format Headings. 

 

 
 

 
 
 

4. In the Caption text box, enter PO Item ID. 
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5. In the Font area, click the drop-down list for Color and select red color from the Color Selector dialog box and 
click OK. 

 

 
 

6. In the Cell area, click the drop-down list for Background Color and select a light blue color from the Color 
Selector dialog box and click OK. 

 

 
 

7. Change the Cell Value Alignment to Center from the drop – down menu. 
 

 
 

8. Click OK in the Edit Format dialog box to see the results of your format changes for PO Item ID. 
 

Verify Preview pane to check the change: 
 

 
 

Click Done. 
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4.5 Edit Value Format 
 

The Column Properties button allows you to edit column and table headings, hide individual columns, change the physical 
alignment of the results, edit column labels, and modify the format of the displayed data. 
By default, the Analysis Editor uses a specific style sheet to display analysis results. When you build or modify an analysis, 
you can override the default settings and specify how the data within a column displays.  
You can edit the column properties in both the Criteria and Results view. However, the Results view allows you to 
customize both the header and the column values.  
The formatting options you select apply only to the analysis with which you are working, but you can import the designated 
format into other analyses. 

 

  

1. To edit Values of the analysis, click Edit View  icon on the Table view. 
2. Table View Editor will open. 

 

 
 

3. In the Layout editor, click the More Options icon  for PO Item ID and select Format Values. 
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4. In the Font area, click the drop-down list for Color and select red color from the Color Selector dialog box and 

click OK.  
 

5. In the Style drop-down list select BOLD. 

 
 

6. In the size box, enter value as 10. . 
 

Click OK. Check the preview layout to see the PO Item ID values format. 

 
   

7. Click Revert and then Done. 
Note: We are not saving this format change, this is an example for the class. 
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4.6 Edit Data Format 
 

The third tab within the Column Properties window allows you to override the default for alphanumeric data. This function 
is often used in conjunction with numerical data, such as percent, currency, to designate the number of decimal digits; or 
with dates, to designate a different mm/dd/yyyy format and month/day name instead of a number (April instead of 4). 
Refer to the Oracle documentation for more information on supported formats. 
 
Some data elements may have the red parenthesis as the default data format for negative numbers, but not all. In addition, 
some columns may actually be text fields so you cannot reformat them. 
 
Make sure to open the “Count of PO’s by Item ID” and select the Results tab as shown below. 
 

 
 

  

1. Return to the Criteria tabbed page. 
 

2. Edit the column properties for Count of PO’s. Click the More Options icon and select Column Properties. 
 

 
 

The Column Properties dialog box appears. 
 

3. Select the Data Format tabbed page 
 

4. Select the Override Default Data Format checkbox and select the values as indicated below in the image 
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Elements Desciption 

1. Treat Numbers As Select the Format of the Number from the available drop – down list. 

 
2. Negative Format Choose the format in which way you want to represent the negative 

values in the output. 

 
3. Decimal Format Select no. of decimals you want to display after the number. 

 
4. Use 1000’s Separator Enabling will use 1000’s separator in the output result. 
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4.7 Apply Conditional Format 
 

Conditional formatting helps direct attention to a data element when the value meets a certain condition. You can establish 
conditional formatting within a column by specifying criteria and indicating the use of distinct font, cell, border, and setting 
options when the condition is met. These types of conditional formats can include colors, fonts, images, and so on, for both 
the data and for the table cell that contains the data. 

 

  

1. Return to Criteria tabbed page. 
 

2.  Edit the column properties for Union Code. Click the More Options icon and select Column Properties. 
 

3. The Column Properties dialog opens. Click on Conditional Formatting. 
 

 
 

4.  Let’s add a condition to highlight Count of PO’s value when greater than 10. So click on Add Condition to select 
Count of PO’s column. 

 

 
 
 

5. A Edit box opens. Select COUNT(DISTINCT PO ID) is greater than 10. Click OK. 
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6. Edit Format dialogue opens. Change the background color as shown in below figure. 
 

  
 

Click OK. 
 

7. The Conditional Format screen now will appear as shown:-  
 

 
 

8. Click OK. And go to Results tab to see the data. See the results for the Count of PO’s grater than 10 as shown 
below 
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9. To delete the conditional format, return to Criteria tab and go to PO Item ID column properties. 
In conditional Fromat tab, go to the condition and delete. And click OK. 

 

 
 

 10. Go to Result tab to see conditional format is removed. 
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5. Customize Analysis View 
 

Introduction Views use the presentation capabilities of OBI to help you look at results of analyses in 
meaningful, intuitive ways. You can add a variety of views to the results, such as graphs and 
pivot tables that allow drilling down to more detailed information, explanatory text, a list of 
filters that were used to limit the results, and more. 
When you display the results of a new analysis, the following views are displayed by default 
in the "Compound Layout" in the "Analysis editor: Results tab": 

 A title view, which displays the name of the saved analysis. 

 A table or pivot table view, which displays the results of the analysis, depending on 
the types of columns that the analysis contains: 

 If the analysis contains only attribute columns, only measure columns, or a 
combination of both, then a table is the default view. 

 If the analysis contains at least one hierarchical column, then a pivot table is the 
default view. 

You can customize or delete the existing views for an analysis, add other views, and combine 
and position views anywhere in the pane. 
Preparing multiple views of results can help you identify trends and relationships in data. If 
you are customizing results for display on a dashboard, then you can preview how the 
combination and position of views will look when viewed on a dashboard. 
You can then save the analysis with the collection of views. 

Objectives At the end of this section, you will be able to complete the following tasks related to 
customizing Analysis view in compound layout. 

 Type of Views 

 Edit Table Properties 

 Add  & Customizing a Pivot Table 

 Add Graph 

 Format Graph 

 Edit Graph Properties 

 Add Graph to Pivot Table 

 Add View Selector 

 Add Column Selector 

 Delete View 
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5.1 Type of Views 
 

View Name Description 

Compound Layout 

 

You use this view to display and assemble multiple views.  
Note: This is the initial default view until another view type is selected. 

Title  You use this view to add a title, a subtitle, a logo, a link to a custom online help page, and timestamps 
to the results. 
Note: This view is added automatically to analysis results. 

Table  You use this view to show results in a standard table. You can navigate and drill down, add totals, 
customize headings, and change the formula or aggregation rule for a column. You can also control 
the appearance of a column and its contents, and specify formatting to apply only if the contents of 
the column meet certain conditions. 

Pivot Table  You use this view to take row, column and section headings and swap them around to obtain different 
perspectives. You can drag and drop headings to pivot results, preview them and apply the settings. 
You can navigate through pivot tables and drill down into information. You can create complex pivot 
tables that show aggregate and unrelated totals next to the pivoted data, allowing for flexible analysis. 
For an interactive result set, elements can be placed in pages, allowing you to choose elements. 

Graph  You use this view to modify the graph layout. You can customize the title, legend location, axis titles, 
data labels, the size, and scale of the graph, and control colors using a style sheet.  
The Analysis Editor supports a variety of standard graph types, including bar graphs, column graphs, 
line graphs, area graphs, pie graphs, and scatter graphs. 

Funnel  You use this view to show a three-dimensional graph that represents target and actual values using 
volume, level, and color. It is useful for depicting target values that decline over time, such as a sales 
pipeline. 

Gauge  You use this view to display a standard “gauge” graphic to indicate where a measure falls within a 
specific range. You can choose from several gauge graphics, color scheme size and measure highs and 
lows. 

Map view  You use this view to present business data to users. As with views such as tables, pivot tables, and 
graphs, map views allow users to display data on maps in a number of different formats and to 
interact with the data. When data is visualized on a map, relationships among data values that might 
not have been obvious previously can be displayed in a much more intuitive manner. For example, a 
map view can show a map of a city with the zip codes color-coded by sales performance, while an 
image marker displays the average discount given per order. 

Filters  You use this view to show the filters in effect for an analysis. Filters allow you to constrain an analysis 
to obtain results that answer a particular question. 

Column Selector 

 

You use this view to change dynamically which columns display in results. This allows you to analyze 
data along several attributes. By changing the facts, you can dynamically alter the content of the 
results. 

View Selector  You use this view to change the view dynamically by which analysis results are displayed. Multiple 
views must be created in order for the View Selector view to be enabled. 

Legend  You use this view to display specific captions or text for a table axis. You can adjust the font and 
location of the legend within the view. 

Narrative  You use this view to display the results as one or more paragraphs of text. You can type in a sentence 
with placeholders for each column in the results, and specify how rows should be separated. 

Ticker  You use this view to display the results as a ticker or marquee, similar in style to the stock tickers that 
run across many financial and news sites on the Internet. You can control what information is 
presented and how it scrolls across the page. 

Static Text  You use this view to include static text in the results. You can use HTML to add banners, tickers, 
ActiveX objects, Java applets, links, instructions, descriptions, graphics, and so on, in the results. 
 

Logical SQL  
You use this view to show the SQL generated for the analysis. This view is useful for trainers and 
administrators, and is usually not included in results for typical users. You cannot modify this view, 
except to delete it. 

5.2 Table Properties 
  
 Understanding Table Properties:- 
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 Elements  Description 

1. Data Viewing a. Fixed headers with scrolling content:- This will allow us to 
enter Maximum width and height sizes. By enabling this it 
will disable option 2 and 3. 

b. Content Paging:- This is the arrow marks which can be viewed 

at the end of table. . It will by default gives 
100 rows per page. 
Single arrow will only display only the next 100. 
Double arrow will display all the rows. 

2. Paging Controls It will give you the option of where to display the Content Paging on 
the page. 

3. Rows per Page By entering a value in the box it will display only that no. of rows. By 
default it will display 100 rows per page. 

4. Display Folders & Column 
Headings 

Choose the value from the drop-down menu to select, so that 
based on that the Folders and column headings will be displayed. 

5. Row Styling It will allow us to change the color or format or other formats. 

6. Master - Detail Use this box to specify whether a table or pivot table is to act as a 
detail view in a master-detail relationship and listen for master-
detail events. Select this box and then specify the channel or 
channels in the Event Channels field. 

7. Null Values It will include rows with only Null Values. 

 
 
The properties of views in compound layout can be changed in the following ways:- 
 
Make sure to open the “Count of PO’s by Item ID” and select the Results tab by clicking on Edit as shown: 

 

  
 

1. Click on Edit icon of the Table view. 
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2. On top of Preview pane In the toolbar section like on “Table View Properties”.  
 

 
 

3. Table Properties dialog opens 
 

 
 

4. After the changes, click OK then click Done. 

 

5.3 Add a Pivot Table 
 

A pivot table is a table that you can use to summarize large amounts of data quickly. You can rotate rows and columns to 
see different summaries of the source data, as well as add column and row grand totals. 
 
Use the Pivot Table view, an additional view available with the results layout, to alter the layout and functionality of a 
conventional table view. The pivot table view is an interactive view that allows you to rotate the rows, columns, and section 
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headings to obtain different perspectives of the data. Pivot tables are navigable and drillable, and are especially useful for 
trending and comparative analyses. 

 
The elements of a Pivot Table: 
·          Pages create a separate filter within the pivot table, based on the moved column  
·          Sections create table breaks within the pivot table, based on the moved column  
·          The More Options button enables you to duplicate columns, modify how data is presented, and calculate sums, 
averages, percentages, etc. 

 
Next let’s add Pivot table to the compound layout of Count of PO’s by Item ID Report. 

  

  

1. On Results tab of Count of PO’s by Item ID, click on New View icon from the tool bar on top of Compound Layout to 
click on Pivot Table. 

 

 
 

It will add another view in the compound layout under the table view. 
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It will also show on the Views Pane on the left side of the screen as shown in above screenshot. 
 

2. In this exercise, we will create pivot table based on Count of PO’s per Business Unit. 
 

Click on the Criteria tab and Add PO Business Unit under Business unit Folder to the existing report. 
 

 
 
Click on Results 
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Click on Edit View icon  on Pivot Table. 
 

 
 

3. Pivot table layout editor opens: 
 

 
 

4. In the Layout pane, the following section is similar to the Table Edit View. 
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Elements Desciptions 

1. Pivot Table Prompts It is used to reduce the rows and to retrievew the data quickly. 

2. Sections It is used to see the data according to the particular desciption values. 

3. Pivot Table In this section, we can swap the columns @ different perspective to get 

output as different view. Using the edit more option menu, can 
color and modify the report headings name, size and the value to fit to 
the table. 

4. Excluded It is used to Exclude columns from the report. And can be included when 
needed. 

 
5. Exclude PO Line Item ID, PO Line Item Description, Max Price and Min Price Columns in Pivot 

 

 
 
In the Measures column, edit column by clicking on more option as shown in below screenshot 
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Elements Desciption 

1. Format Heading It is used to edit the column name 

2. Format Values It is used to edit the values 

3. Show Data as It is used to show values as ‘values’, ‘percent of’, ‘index of’ 

4. Aggregation rule It is used to calculate the measure values as different functions are 
sum, min, max, Avg, first, last, count, count distinct, none. 

5. Display as running 
sum 

It is used to calculate the values according filters and condition @ 
running time of the report. 

6. Duplicate Layer It is used to make duplicate copy of the same column, to use the 
column more than one time for different condition and in various 
perspective on the same report 

7. Remove Column It is used to remove column from all  perspective of the report 

 
6. Since in this excerise we are creating a report to find count based on business unit, so move all columns to 

Excluded section and put PO Business Unit in the Rows section as shown:-  
 

 
 

Check the preview layout to verify the data. 
 

7. On the pivot table layout, Rows – click on summation button to calculate the total values according to column of 
measure values, options to show the total values as in row format. 
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Elements Description 

None It shows no total 

Before It shows the total value as in row format before the rows 

After It shows the total value as in row format at the end of the rows 

Format Labels & Values It is used to edit the content heading and values 

 
8. Click on “After” and see the results in preview pane. And also see that the Summation icon is highlighted with 

green tick mark. 

 
 

9. Click Done to view the Pivot table in compound layout. 
 

 
 

 
10. We will rename this Pivot table as “By Business Unit”.  Go to Views section and select the Pivot Table view and 

Click on rename icon . Follow the below screenshots: 
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11. Let’s create an another following pivot table views in similar way :- By Item ID 
 

 
After creating views the screen will display as follows:-  
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Save the Analysis. 
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5.4 Add a Graph 
 

Once you create and run an analysis, you can display results in a graph format. Graphs display a graphical representation of 
the extracted data. You can add a graph view to analysis results, or you can replace the table with a graph. 

 
Note: You must click the Save button and resave the analysis in order to add the graph permanently to the results display. 

 

The following are types of Graphs:- 

Graph Type Description 

Bar 

 

Shows quantities associated with categories. Bar graphs show quantities as bar 
lengths and categories as bars or groups of bars. 
Bar graphs are useful for comparing differences among like items; for example, 
competing product sales, same product sales over different time periods, or same 
product sales over different markets. 
Can be used to compare measure columns by showing bars in a horizontal or vertical 
direction. 

Line   
 

Shows quantities over time or by category. 
Line graphs are useful for showing trends over time. 
Can be used to plot multiple measure columns. 

Area  

 

Shows the trend of the contribution of each value over time or by category. 
It is a line graph for which the regions between lines are filled in. Regions stack, 
adding up to the total value for each time period or category. 

Pie  Shows data sets as percentages of a whole. 
Pie graphs are useful for comparing parts of a whole, such as sales by region or by 
district. 

Line-Bar  

 

Plots two sets of data with different ranges, one set as bars, and one set as lines 
overlaid on the bars. 
Line bar graphs are useful for showing trend relationships between data sets. 

Time Series Line 

 

Plots time series data. It scales the horizontal axis based on the time that has 
elapsed between data points. 

Pareto 

 

Is a form of bar graph and line graph that displays criteria in descending order. In 
this graph type, the line shows a cumulative total of the percentages. 
Pareto graphs are useful for identifying significant elements, such as best and worst 
or most and least. 

Scatter 

 

Displays x-y values as discrete points, scattered within an x-y grid. It plots data 
points based on two independent variables. This enables you to plot large numbers 
of data points and observe the clustering of data points. 
Scatter graphs are useful for observing relationships and trends in large data sets. 

Bubble 

 

Is a variation of a scatter graph that displays data elements as circles (bubbles). It 
shows three variables in two dimensions. One value is represented by the location 
of the circle on the horizontal axis. Another value is represented by the location of 
the circle on the vertical axis. The third value is represented by the radius of the 
circle. 
Bubble graphs are useful for plotting data with three variables, and for displaying 
financial data over a period of time. 

Radar 

 

Plots the same information as a bar graph, but instead displays data radiating from 
the center of the graph. Each data element has its own value axis. 
Radar graphs are useful for examining overlap and distribution. 

 
 

                

In our exercise, we will add a Vertical Bar graph. 

Guided Exercise 
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i. Click the Results tabbed page, click New View icon. 

 

 
 

3. Select Graph > Bar > Vertical from the menus. 
 

 
 

The default Graph view appears below the Pivot table views. 
 

 
 

4. Click the Remove View from Compound Layout icon for Title and all the above views (Table & 2 Pivot tables) 
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Note: Both views are removed from the Compound Layout. Note however, that they are still available for use from the Views pane. 

 

 
 

Go to Criteria tab: 
 

 
 

Edit the PO Business Unit in Filter section and add DOCM1 to existing filter. 
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Save the Analysis. 
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5.5 Format Graph 
 

The default graph for an analysis is a two-dimensional vertical bar graph, drawn using the attributes and measures that are 
selected first within the analysis. You can select additional columns to display within a graph based on what is available in 
the Columns section of the Add/Edit Graph view.  
You can also change the formatting, displayed text, legend, style, and size of a graph, which adjusts the landscape of a 
dashboard page. 

  

  

To enhance the appearance of a graph, perform the following steps: 
 

1. Click the Edit View icon to begin your formatting changes. The Graph editor appears. 
 

 
 

2. Like other views it also has same sections:- 
 

 
 

Next we will create a graph on Total no. of PO’s based on PO Business Unit. 
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3. Let’s move all the columns to Excluded sections except for Count of PO’s in Measures and PO Business Unit in the 
Horizontal Axis section. 
 

 
 

4. Preview the graph in preview pane. 
 

 
 

5. If you want the bar colors to change based on each Union Code value then move the PO Business Unit column 
from Group By (Horizontal Axis) to Vary Color By (Horizontal Axis). 
 

 
 

…Continued into next section 
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5.6 Edit Graph Properties 
 

6. Click on Edit Properties icon. 
 

 
 

7. The Graph properties dialog box appears 
 

 
 

The Graph properties dialog box is composed of four tabbed pages: General, Style, Scale, and Titles and Labels. These 
tabbed pages allow you to do the following: 

 

General Set properties related to the graph canvas, such as canvas width, height, legend location, 
and so on. 

Style Set properties that control the appearance of the graph such as plot area and gridlines. 

Scale Set properties for parts of the graph, that is axis limits and tick marks. 

Titles and 
Labels 

Set properties that control the display of titles and labels for the graph. 

 
8. Select left from the Legend location drop-down list. The dialog box should look like this: 
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Note: The "Animate graph on Display" checkbox specifies whether to show initial rendering effects and is selected 
by default. For example, the bars on a horizontal graph start at the x-axis and move up the scale on the x-axis to 
the current measurement level. 
"Listen to Master-Detail Events" allows you to specify this analysis as a detail view in a master-detail relationship. 
You will use this option in a subsequent step when working with pivot tables 

 
9. Click the Style tabbed page. 

 

 
 

Click the Style drop-down list for Graph Data and select Gradient. The Graph Data area allows you to choose a 
style for specific types of graphs. For example, you might choose pattern fill for to highlight differences on a line-
bar graph or gradient for a bar graph to make the data values standout. 

 
10. Click the Background drop-down list in the Plot area, and select a light blue color from the Color Selector and 

click OK. 
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The Graph properties dialog box should look like this: 
 

 
 

11. Click the Scale tabbed page. The Scale tabbed page appears. 
 

 
 

Specifically setting axis limits and tick marks allows you to control what you see on your graph. If you override the 
system default for tick marks, the colors that you have selected for horizontal and vertical gridlines on the General 
properties tabbed page will be applied to both major and minor ticks. 
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12. Click the Titles and Labels tabbed page. 
 

 
 

13. Deselect the checkbox for Use measure name as graph title and Use measure name as axis title enter No. of 
PO’s in the Title text box. 

 

 
 

14. Click the Format Title icon  for Graph Title. 
 

The "Font Format: Title" dialog box appears. You use this dialog box to specify how titles, legend labels, and so on 
are handled (such as truncated automatically) and to specify font properties. 

 

 
 

15. Deselect the check box for Vertical Axis Title and click OK to close the Graph Properties dialog box. 
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The preview pane refreshes and should look like this: 
 

 
 

Examine the changes that you made to the graph. The formatting changes have been applied along with a new 
title. 

 
Click Done. 
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5.7 Add Pivot Table Graph 
 

A graph can be added to Pivot table. 
  

  

1. Navigate to views section, select “By Item ID” view and click on Edit View icon. 
 

 
 

2. Now in the toolbar click on Graph Pivoted Results icon. 

 
 

3. After clicking on the icon, it opens more graph options on the toolbar and also a graph by default displays on the 
right side of the table. 

 

 
 

Select the option from the tool bar and click Done. 
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5.8 Add a View Selector 
 

A view selector view allows users to select a specific view of the results from among the saved views for an analysis. When 
placed on a dashboard, the view selector is displayed as a list from which users can choose the view that they want to 
display below the selector. 

 
Generally, you would include views in the view selector that are not being displayed in the Compound Layout view. For 
example, you might create a table, graph, gauge, and view selector view for an analysis, but include only the table and view 
selector view on the Compound Layout view. When the analysis is displayed on a dashboard page, users can select the 
graph or gauge view from the view selector view. 

 
 

Next we will add two pivot tables in a view selector (By Business Unit, By Item ID). 
 

  

1. Return to Results tabbed page, click on New View icon. 
 

 
 

2. Click Other Views and select View Selector. 
 

 
 

A new View will be added under the Graph view. 
 

Guided Exercise 
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3. Click on Edit View icon of View Selector. 
 

 
 

A View selector Edit view page will open. 
 

 
 

Elements Description 

Caption Text entered in this place will appear as a caption to the View Selector 

Caption Position It is to select position of the Caption 

Available Views It will show all the available Views 

Views Included It will show the views which are included to show in the View selector. 

 
4. Enter “View” in the text box of Caption.  
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5. Leave the Caption Position as default (Left).  

 

 
 

6. Move By Business Unit, Item ID from Available Views to Views Included using arrows. You can select multiple 
values by holding CTRL. 

 

 
 

7. Check the Preview to see how the View selector will display in the Compound Layout. 
 

 
 

Click Done. 
 

8. Delete Graph View from Compound layout by clicking on the red 'X' in the corner of the Graph view window. 
 

 
 
 
 
 
 
 

9. Compound Layout in Results tab, should appear as shown. 
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5.9 Add Column Selector 
 

The Column Selector view allows you to change dynamically which columns display in an analysis. One column selector can 
be attached to each column in a specific analysis, and multiple columns (attributes) can be attached to each column 
selector. 
Selecting a column enables you to analyze data along several attributes and/or metrics. It also enables you to configure the 
column order within a dashboard to display data in a clearer layout. 

 

  

1. Delete the View selector from the compound layout. 
 

 
 

After deleting View Selector view the compound layout appears as shown below:- 
 

 
 

2. Go to Views section and select Table to click Edit. 
 

 
 

3. The Edit View of the table looks as below: 
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4. Exclude all the columns by leaving PO Business Unit and Count of PO’s in Columns and Measures. 
Click on Summation and click After to get grand total. 

 

 
 

5. Click Done. 
 
 
 
 
6. Return to Results tabbed page. Click New View icon. Go to Other Views to select Column Selector. 
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Column Selector Editor Page appears as follows: 
 

 
 

7. Enable Include Selector in Column 6 PO Business Unit. By checking corrresponding box. 
 

 
 
 
 

8. From Subject Areas section expand folders and double click on following columns: 
  

Purchase Details > select PO Line Item ID 
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9. Click Done. 
 

10. Add Title view and Table view to Compound Layout from Views section. 
 

 
 

11. After adding Table to Compound layout, it appears as below: 
 

 
 

12. Select the value in column selector, based on that column in the first column changes. 
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13. Save the Analysis. 
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5.10 Delete Views 
 

You can remove views from the Views pane when they are no longer useful. This removes the view permanently from the 
Analysis.  
 
Be careful when deleting a view, as there is no warning message.  
 
You must use the Remove View from Analysis button in the Views pane; the Remove View from Compound Layout button 
within the workspace only hides the view. 
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6. Drill down Functionality 
 

Introduction This tutorial shows you how to build and use actions to provide guided 
navigation, link to external web content, and invoke web services. You 
learn how to guide user navigation in dashboards and analyses using 
actions and action links, to access external web content in the context 
of your OBI analysis, to use conditions and agents with actions to 
automate initiation of business processes, and to invoke a Web Service 
using actions and action links. 

Objectives At the end of this section, you will be able to complete the following 
tasks related of Drill Down functionality. 

 Create Analysis 

 Navigate Action Link 

 Create Action Link 

 Test Action Link 
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6.1 Copy an Existing Analysis 
 
 We have created Purchase Order Details analysis and placed under Shared Folders/Training/Procurement and Spend. 
 
 Navigate to the folder and Copy the analysis to paste it under My Folders/Training. 
 

  

1. Navigate to Shared Folders/Training/ Procurement and Spend. 
 

 
 

2. Select Purchase Order Details analysis and click on More Options to select Copy. 
 

 
 

3. Navigate to My Folders/Training. 

 

 
 

4. Click on Paste from Tasks section. 
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5. Purchase Order Details analysis will get pasted in My Folders/Training folder. 
 

 
 
  
 Purchase Order Details Analysis:- 
 

This analysis is created to view Purchase Order Details of those PO’s with  PO Business Unit, Vendor ID, Vendor Name, PO 
ID, PO Line, PO Line Item ID, Contract ID, PO Schedule, PO Quantity and PO Amount and use in Count of PO Report as a 
detail report by creating action link. 
 
This analysis has following columns and filters:-  

 
 Columns: 
 

Folder Name Column Name 

Business Unit  PO Business Unit 

Vendor Details > Vendor Vendor SETID 

Vendor Details > Vendor Vendor ID 

Vendor Details > Vendor Vendor Name 

Purchase Order Details PO ID 

Purchase Order Details > Purchase Header PO Entered Date 

Purchase Order Details > Purchase Header PO Status 

Purchase Order Details > Purchase Line PO Line Item ID 

Purchase Order Details > Purchase Line Item Description 

Purchase Order Details > Purchase Line PO Line Number 

Purchase Order Details > Purchase Schedule PO Schedule PO Price 

Purchase Order Details > Purchase Schedule PO Schedule Number 

Procurement Contract Details  Contract Id 

Procurement Contract Details > Procurement Contract Header Contract Begin Date 

Procurement Contract Details > Procurement Contract Header Contract Expire Date 

Requisition Details Requisition ID 

Fact – Purchase Orders PO Quantity 

Fact – Purchase Orders PO Amount 

  
 
 
 

Filters: 
  

Column Name Operator Condition 

PO Business Unit Is equal to / is in DOTM1; DOCM1 

Accounting Year Is equal to / is in 2016 

PO Line Item ID Is prompted  

Item Description Is Prompted  

The columns and conditions in the analysis will appear as shown below. 
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Note: We will use the above analysis and “is prompted” filters when creating a dashboard page and placing the analysis on the 
dashboard. The values from the Dashboard Prompt will then use these filters to display the results. 
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6.2 Create Action Link 
  

An action link is a link to an action that you have embedded in an analysis, dashboard page, scorecard objective, 
scorecard initiative, or KPI that, when clicked, runs an associated action. 
 

1. Action link is available in column properties of a column by going to Interaction tab. 
 

 
 

 
 

2. Action links can be added in Column Heading or in Value by clicking on drop down menu. 
 

 
 

3. Click on Action Link:- 
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Elements Description 

1. Action Links In the Action Links list, you can view, add, edit, and delete 
actions associated with the column. Notice that you can have 
multiple action links associated with a column. By default, 
actions available for a column appear in a popup when a user 
clicks the column value or heading in an analysis. 

2. Do not display in a 
popup if only one 
action is available at 
runtime 

This option is used to reset, so that in the event only one 

action is available for a value or heading, the action is executed 
upon the user interaction. Leave this option unchecked 

3. Enable on Totals This option is used to enable action links for Grand Totals 
and Sub Total level. 

4. Add Action Link  To add Action Link 

5. Edit Action Link  Used to edit an existing analysis. 

6. Delete Action Link 

 

Delete an existing analysis 

 

4. Click the Add Action Link button . 
 

New Action Link window displays: 
 

 
 

Elements Description 

1. Link Text Enter some text in the “Link text”, this will popup whenever 
the user clicks on the column value 

2. Action Choose the type of action link.  In this exercise we will 
choose “Navigate to BI Content” as we are going to navigate 
to a page within our dashboards. 

3. Show Link It is used to apply conditions based on which the action link 
needs to apply 

4. Add Action Link  Choose the type of action link.  In this example we will 
choose “Navigate to a BI Content” as we are going to 
navigate to another analysis. 

 
5. Select existing 

Action  

Choose an action link which has been already created and 
saved in the folder. 

6. More   This option is used to edit or remove or save action link as. 
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Next we will create action link between Count of PO’s by Item ID and Purchase Details Report. 

  

 

1. Navigate to My Folder/Training folder and select Count of Po’s by Item ID” to click on Edit. 
 

 
 

2. Click on Criteria tab and in Selected Columns section Hover over Count of PO’s column More icon and select 
Column Properties from dropdown menu. 

 

 
 

3. Column Properties dialoge opens, click on the Interaction tab. 
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4. In the Value section (not the Column Heading section) select Action Links from Primary Interaction drop down 
menu. 

 

 
 

5. Click on Add action link icon . 
New Action Link… dialoge opens 

 

 
 

6. Enter “Purchase Details” in Link Text box.  
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7. Click on Create New Action icon  to select “Navigate to BI Content”. 
 

8. Select BI Content for Action dialoge opens, navigate to My Folders/Training folder and select Purchase Order 
Details analysis.  

 

 
 

9. Click OK. 
 

10. Create New Action dialoge appears as follows:- 
 

 
  

Click OK then again Click OK to close New Action Link dialogue. 
 

11. Interaction tab displays as follows: 
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Click OK to close column properties dialoge. 
 

12. Save the Analysis. 
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6.3 Test an Action Link 
 

 

1. Click the Results tab. 
 

 
 

2. In the Results tab, all the values are highlighted with action links. 
 

 
 
 
 
 
 

3. Click on a value in the Count of PO's column, then click on the Purchase Details link. 
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4.  It will open a new window and will give you the PO Details of that CM_2157_59241 Item. 
 

 
 

This release contains a new feature: Breadcrumbs.  
Breadcrumbs have been added to help you understand your current location within OBI content and the path 
that you have used to navigate OBI content. 
Observe the bottom left corner of My Dashboard. Breadcrumbs are active links that you can click to return to 
the place from which you navigated and to the state of the content when you left it. 

 

 
 

5. Click on Count of PO’s by Item ID to return.  
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7. Search, Print and Export Analysis 
 
 

Introduction We can search for objects in the Oracle BI Presentation Catalog. 
You can print analysis results to HTML and PDF formats. Additionally, you can export a 
complete list of analysis results to the following formats: 

·         Download to Excel 2003 +exports the data in and the formatting as it displays in 
the view, including graphs, filters, etc… 

·         The Download Web Archive is an HTML page and not modifiable. 
·         Download Data exports just rows of data without formatting. 
·         Download to PowerPoint exports to PowerPoint 

In this module, you will learn how to display analysis results in PDF format and Microsoft 
Excel©. 

Objectives At the end of this section, you will be able to complete the following tasks relating to: 

 Search an Analysis 

 Print Results to PDF 

 Export Results to Excel© 
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7.1  Search for an Analysis 
 

The basic catalog search allows you to search for an object from the Global Header, Home page, or Catalog page. You can 
search for an object by its name, location, or type only, which is similar to using a Find dialog box in many products. You will 
find only those objects for which you have the appropriate permissions. When the desired object is located, you can click it 
to display it for viewing or editing, as your permissions allow. 
 

 Understanding Search elements:- 
 

 
 

Elements Description 

Search Enter the name of the Analysis, Dashboard, Prompts and so on.  

Location Choose in which folder you want to search. 

 
Type Select the type of the Search you’re looking for. 

 
 

  

To search an analysis, follow the below steps: 
 

1. On home page, click on Catalog in Global header. 
 

2. Now click on Search icon  in the Common Header.  
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3. Enter Count of Pos by Item ID under Search. And select My Folders as Location. Click Search. 
 

 
 
Now it will display all the reports with Count of Pos by Item ID along with their folder path in My Folders. 
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7.2 Print Results to PDF 
 

You can export analyses to a PDF format. By exporting analyses, you have the ability to print analyses as well as send an 
analysis to an individual. 

 

  

            Go to Results tabbed page, and click on Print this Analysis icon. 

 

 
 

1. Click on Printable PDF, a new window opens with PDF version of the results. You can either save the analysis as 
PDF in your desktop or give print to printer. 
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7.3 Export Results to Excel 
 

You have the ability to export an analysis to Microsoft Excel©. By exporting to Microsoft Excel©, you can save, print, email or 
manipulate the data in a spreadsheet. 
 

 

1. Click Export this analysis icon on Results tabbed page. 
 

 
 

2. Click Excel and Save the file 
 

 
 

3. Save this Analysis. 
 

8. Work with Dashboard Prompt 
 

Introduction A dashboard prompt is a special filter that filters analyses embedded in a dashboard. 
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The prompt created at the dashboard level is called a Dashboard Prompt, because, the 
prompt is created outside of a specific dashboard and stored in the catalog as a prompt 
object, which can then be applied to any dashboard or dashboard page that contains the 
columns, which are specified in the prompt. It can filter one or any number of analyses 
embedded on the same dashboard page. You can create and save these named prompts 
to a private folder or a shared folder. 
 

o A Dashboard Prompt is interactive and will always appear on the dashboard page so that 
the user can prompt for different values without having to rerun the dashboard. 

o A Dashboard Prompt can also interact with selection steps. You can specify a dashboard 
prompt to override a specific selection step.  
The step will be processed against the dashboard column with the user-specified data 
values collected by the dashboard column prompt, whereas all other steps will be 
processed as originally specified. 

Objectives At the end of this section, you will be able to complete the following tasks related to 
creating Dashboard Prompts. 

 Create a Dashboard Prompt 
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8.1 Understand a Dashboard Prompt 
 

A prompt that is created at the dashboard level is called a dashboard prompt because the prompt is created outside of a specific 
dashboard and is stored in the catalog as an object, which can then be added to any dashboard or dashboard page that contains the 
columns that are specified in the prompt.  Dashboard prompts are reusable, because you can create one prompt and use it many times. 
When the prompt object is updated and saved, those updates are immediately displayed in all dashboards where the prompt is used. 
A dashboard prompt is interactive and is always displayed on the dashboard page so that the user can prompt for different values 
without having to re-run the dashboard. Users can create and save dashboard prompts to either a private folder or to a shared folder. 

  
 Navigating and Understanding Dashboard Prompt 
 

1. Dashboard prompt screen opens which will have two sections Definition & Display section. 
 

 
 

The Definition pane allows you to add, organize, and manage a named prompt's columns. You can use column 
prompts, image prompts (maps), currency prompts, and variable prompts. The Definition table lets you view high-
level information about the prompt's columns. You can also use this table to select columns for editing or deleting, 
arrange the order in which the prompts appear to the user, or insert row or column breaks between prompt items. 

 
 The Display pane is a preview pane that allows you to view the prompt's layout and design. 
 

2. Definition pane:-  

 
 
 
 

Elements Description 

1. New Used to add a new Column prompt, Variable prompt or 
Image prompt 

2. Column / Row 
based layout 

This is used to select the type of layout you want on the 
prompts page either Column or Row based. 

3. Edit Edit Prompt 

4. Delete Delete Prompt 

 
3. New Column Prompt dialog, for example we will select Year. 
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Elements Description 

1. Prompt for Column It shows the column name of the prompt 

2. Label It is label which will be displayed 

3. Custom Text Enable this to change the default Label 

4. Description We can add description for this column 

5. Operator Choose appropriate operator 

6. User Input The User Input field's drop-down list appears for column and 
variable prompts and provides you with the option to determine the 
User Input method for the user interface—in other words, the user 
will see one of the following: check boxes, radio buttons, a choice 
list, or a list box. . You use this item in conjunction with the Choice 
List Values item to specify which data values appear for selection. 

7. Choice List Values The Options section provides you with the opportunity to constrain 
values available for selection.  

 

8.  

The series of checkboxes allow you to restrict the amount of data 
returned. Select Enable user to select multiple values, and Require 
user input. Allowing multiple selection of values lets you choose 
more than one value (region for example), and requiring input forces 
you to enter at least one value. 

9. Default Selection It allows you to selection an initial value 

10. Choice List Width You the change the width of the Choice List by enabling dynamic or 
fixing it. 

11. Set a variable It allows you to create a new variable that this column prompt will 
populate 

 

8.2 Create Dashboard Prompt 
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 Next we will create Dashboard Prompt with two columns from Procurement and Spend - Purchase Orders subject area. 
 

 

1. Click on New icon from global header and select Dashboard Prompt. 
 

 
 

2. Select Procurement and Spend - Purchase Orders from the Subject Area dialog. 
 

 
 

It will open Dashboard Prompt window: 
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3. Click on New icon   and select Column Prompt. 
 

Subject Area with select column dialog opens: Expand Accounting Date and select Accounting Year. 
 

 
 

4. New Prompt dialog opens. Leave the defaults in the top section. 
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5. Click on Choice List Value drop down menu to select “Specific Column Values”. Then click on Add icon next to it, 
and select Years from 2011 to 2016. 
 

 
 
 

6. Enable Require user Input.  
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7. Click on Default selection drop down menu to select Server Variable and then type CURRENT_YEAR. 
 

 
 

8. Click OK to close the Prompt. 
 

9. The Definition pane and Display pane appears as follows:- 
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 Next we will add PO Business Unit in similar way. 
 

1. Click Add icon to select Column Prompt and select PO Business Unit by expanding Business Unit folder. 
 

 
 

2. PO Business Unit Prompt dialog opens: 
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3. Enable Limit values by. 
 

 
 
 

4. Change Default Selection to Specific Values and Choose DOTM1 and click on OK.  
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5. Click OK to close the dialog and see the Defintion and Display pane. 
 

 
 

6. In Display pane the prompts layout is based on Column. We will change it to Row based layout. 

Click on Row based layout icon . 

 
 

7. Save Dashboard Prompt under My Folders/Training as PO Prompt. 
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Click OK 
 

8. Navigate to My Folders/Training to view the Dashboard Prompt. 
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9. Build & Design Dashboard 
 

Introduction In this topic, you will learn about My Dashboard view and adding a saved analysis and 
dashboard prompt that you have created previously. Dashboards provide personalized 
views of corporate and external information. Based on your permissions, you can view 
pre-configured dashboards or create your own personalized views. Users with 
administrative privileges can create shared dashboards for groups of users with common 
responsibilities or job functions. The ability to create and edit dashboards is controlled 
by the Manage Dashboard privilege, which is managed by the administrator. 
You can view your personalized views by selecting My Dashboard from the Dashboards 
drop-down list. You can also set My Dashboard as your default dashboard. Pre-
configured dashboards appear in the Dashboards drop-down list. They can be created by 
administrators and shared with groups of users with common responsibilities or job 
functions. 

Objectives At the end of this section, you will be able to complete the following tasks related to 
building a Dashboard. 

 Understanding & Navigating My Dashboard 

 Build My Dashboard 

 Edit My Dashboard 

 Save a Dashboard Customization 

 Set Preference 

 Export My Dashboard to Excel Spreadsheet 
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9.1 Understanding and Navigating My Dashboard 
 

Understanding Dashboards 
 
Dashboards consist of multiple pages, which display as tabs across the top of the dashboard screen. Additionally, Analysis 
Editor Users have a personal dashboard, called My Dashboard, which enables you to personalize content to meet your 
requirements. 

Pages can display anything that you can access or open with your Web browser, such as saved OBI analyses, images, graphs, 
tables, text, and links to Web sites and documents. 

Dashboard objects are items that are used only in a dashboard. Examples of dashboard objects are sections to hold content, 
navigation links, and embedded content appearing within a frame in a dashboard. 

You can add content to your personal dashboard by clicking and dragging it from the Dashboard Objects section onto the 

dashboard layout page, which consists of columns used to align content, and sections used to hold content. The look of a 

dashboard, such as background colors and the size of text, is controlled by styles and skins. You can modify individual 

objects on the dashboard to change the overall page appearance. 

 Navigate My Dashboard 
 

1. The initial My Dashboard page. 
 

 

 
When you open a dashboard, including My Dashboard, the content appears in one or more dashboard tabbed 
pages. Pages contain the columns and sections that hold the content of a dashboard, and every dashboard has at 
least one page. Multiple pages are used to organize content. 
This example shows an empty My Dashboard page with no content. Hover over the Edit icon to edit the dashboard 
and add content. 

 
 

Note: If you have chosen or if your company has setup My Dashboard as your default, then you use dashboard template pages to 
populate your personal dashboards (My Dashboard) when you first log in as a new user. This allows you to see one or more dashboard 
pages with content, rather than an empty dashboard. It also gives you a starting point to build your own dashboard pages. 
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2. The Dashboard Builder appears and automatically creates page 1 of your dashboard (the first tabbed page). 
 

Using the Dashboard Builder, you can add pages and objects to a dashboard and control the page layout. The 
Dashboard Builder is composed of the following: 

 

 
 

Sections Description 

1. Dashboard Toolbar The toolbar allows you to perform tasks such as adding or deleting 
pages, previewing, saving, and so on. 

2. Dashboard Objects 
pane 

Items that are used only in a dashboard. Examples of dashboard objects 
are sections to hold content, action links, and embedded content that is 
displayed in a frame on a dashboard 

3. Catalog pane Items that you or someone else has saved to the Catalog, for example, 
analyses, prompts, and so on. In a dashboard, the results of an analysis 
can be shown in various views, such as a table, graph, and gauge. (The 
results of an analysis are the output that is returned from the OBI Server 
that matches the analysis criteria.) Users can examine and analyze 
results, save or print them, or download them to a spreadsheet. 

4. Page Layout pane This is a workspace that holds your objects, which are displayed on the 
dashboard. 

 
Dashboard Object Pane: -  
 

As mentioned above, the Dashboard Objects pane provides you with a list of objects to add as content to a 
dashboard page. You will have to drag the object to the Page Layout pane on the right. 
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Two most imp objects used from Dashboard Object pane are as follows:-  
 
Columns are used to align content on a dashboard. (Sections within columns hold the actual content.) You can 
create as many columns on a dashboard page as you need. 
 

 
 

We can click on Column Properties of Column and change the style, alignment, font, color and soon. 
 

Sections are used within columns to hold the content, such as action links, analyses, and so on. You can drag and 
drop as many sections as you need to a column.  

 
 

Elements Desription 

Conditions You use conditions to determine the following:  
Whether sections and their content appear on the dashboard page 

 Whether agents deliver their content and execute their actions 

 Whether action links appear on dashboard pages 
Conditions are evaluated based on a Boolean expression; in other words, 
the condition is either True or False 

Format Section Use this option to display the Section Properties dialog box, where you 
specify the properties for the section, such as cell alignment and border 
color. 

Rename Use this option to display the Rename dialog box, which allows you to 
rename the section. 

Drill in Place Use this option to specify how the results appear when a user drills in an 
analysis. If a check mark appears in front of the “Drill in Place” option, the 
original analysis is replaced when the user drills (the section will 
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automatically resize to fit the new analysis). If the check mark is not 
present in front of “Drill in Place,” the entire dashboard content is 
replaced. Use this option for prompts that are created for hierarchical 

columns.  
Note: You can use the back button in the browser to view the original 
analysis. 

Collapsible Use this option to specify whether the user can expand and collapse this 
section on a dashboard page or whether the section is always expanded. If 
a check mark appears in front of the Collapsible option, you can expand 
and collapse the section. 

Show Section 
Header 

Use this option to specify whether  to display the header for the section, 
which initially includes the title of the section. You can hide the title using 
the Show Section Title option. 

Show Section 
Title 

Use this option to specify whether to display the title of the section. 

 
Dashboard Toolbar pane: -  
 

The toolbar allows you to perform tasks such as adding or deleting pages, previewing, saving, and so on. 
 

 
 

  

Add Dashboard Pages  
It is used to add pages on the dashboard 

Delete Current Page  
When there are single or multiple page then It deletes the 
current page. 

Tools  
It provides options to set dashboard properties, Print options, 
set page report links, and so on 

Preview  
We can Preview the content on the dashboard before saving 
the Dashboard 

Run  
After saving the dashboard page click on Run to view the 
Dashboard. 

 
 

Dashboard Properties:- 
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Elements Description 

1. Style Styles control how dashboards and results are formatted for display, 
such as the color of text and links, the font and size of text, the borders 
in tables, the colors and attributes of graphs, and so on 

2. Description Descriptions are displayed when OBI Administrators use the Catalog 
Manager 

3. Page Size Use these options to specify how a dashboard page is to be sized 
Fit Content — This option sizes the container to the content with no 
wrapping. If the browser window is smaller than needed to fit the 
content, a scroll bar is displayed. 
Fill Browser Window -  Sizes dashboard columns to the largest section 
in each column 
Expands columns (except columns for which a specific absolute size 
has been specified) and sections proportionally to fill the browser 
window, if there is any additional horizontal space in the browser 
window. 
Aligns content within columns and sections in the center, by default 

4. Filters and 
Variables 

To define default filters and variables, embed dashboard prompts with 
default values. These prompts will not be shown on the dashboard. 

5. Dashboard 
Report Links 

The report links at the dashboard level. Report links can be set at the 
dashboard, dashboard page (click Page Options> Page Report Links), or 
analysis level (click the properties icon for the specific analysis within 
the Dashboard Builder and then select Report Links). 

6. Prompt Apply 
Buttons 

Use this list to specify if you want to include or exclude the 
prompt's Apply buttons on the dashboard at runtime 
Use page setting — Select this option to use the Apply buttons as 
defined by the dashboard page settings 
Show All Apply buttons — Select this option to override the 
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dashboard page setting's Apply button preferences and show 
the Apply buttons for the prompts included on the dashboard and 
embedded analyses 
Hide All Apply buttons — Select this option to override the dashboard 
page setting's Apply button preferences and hide the Apply buttons 
for the prompts included on the dashboard and embedded analyses. 

7. Prompts Reset 
Buttons 

Use this list to specify whether you want to include or exclude the 
prompt's Reset buttons on the dashboard at runtime 
 Use page setting —Select this option to use the Reset buttons as 
defined on the dashboard page settings 
Show All Reset buttons — Select this option to override the dashboard 
page setting's Reset button preferences and show the Reset buttons 
for the prompts included on the dashboard and embedded analyses. 
Hide All Reset buttons — Select this option to override the dashboard 
page setting's Reset button preferences and hide the Reset buttons for 
the prompts included on the dashboard and embedded analyses. 

8. Prompts Auto 
Complete 

Use this option to enable or disable the auto-complete functionality for 
the dashboard. When enabled, OBI suggests and highlights matching 
prompt values as the user types in the dashboard's prompt selection 
field, and highlights matching prompt values in the "Select Values 
dialog" 

9. Dashboard Pages Displays the pages in the dashboard. Use this area to perform 
operations (such as hide or rename) on dashboard pages using the 
dashboard pages toolbar buttons. 

10. Dashboard Page 
toolbar 

This toolbar contains the following buttons: 

 Rename — Use this button to display the "Rename dialog", 
where you specify a new name for the page in the dashboard. 

 Select a prompt to capture default filters and variables — 
Use this button to display the "Filters and Variables – page 
dialog", which enables you to add hidden named prompts to 
the dashboard page. 

 Permissions — Use this button to display the "Permission 
dialog", where you specify which accounts have which levels 
of access to the contents of the dashboard page. 
The Permissions button is displayed for shared dashboards 
only, and only if your user ID is authorized to access the 
security features. 

 Delete — Use this button to delete the page from the 
dashboard. After you click the button, you see a page that 
prompts you to confirm the deletion. 

 Specify Who Can Save Shared Customizations — Use this 
button to display the Permission dialog, where you specify 
which accounts can save shared customizations for the page. 

 Specify Who Can Assign Default Customizations — Use this 
button to display the Permission dialog, where you specify 
which accounts can assign default customizations for the 
page. 
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9.2 Build My Dashboard 
 
 In this section, we will build My Dashboard which will have two pages. 
 

 

1. Click the Dashboards link on the global header and then click My Dashboard. 
 

 
 

An empty My Dashboard page appears. 
 

 
 

2. Click the Edit icon ( ) to add content to your empty dashboard page. 
 The Dashboard Builder appears and automatically creates page 1 of your dashboard (the first tabbed page). 
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3. Drag the Column object onto the Page Layout pane. 
 

 
 
The Column object appears on the Page Layout pane 
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4. In the Catalog pane, navigate to the folder where you saved your analyses 
 

 
 

 
5. Drag PO Prompt to Column 1. 

 

 
 

6. Drag Count of PO’s by Item ID Analysis to Column 1 and place it under Section 1. 
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7. Click the Save icon ( ) to save the dashboard page and then click the Run icon  
My Dashboard appears with the selected analysis Count of PO’s by Item ID using Dashboard Default prompt As of 
Accounting Year and Business Unit. 

 

 
 

8. Click on the Amount link and it will take you to the detail report. 
 

9. Scroll Down to bottom of page and at the end of the table there are arrow buttons with no. of rows displaying if the 
rows returned are more than 100. 
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9.3 Edit My Dashboard 
 

To begin enhancing My Dashboard, perform the following steps: 
 

 

1. Click on Dashboards > My Dashboard 
 

  
 

2. Click the Page Options icon (  ) and select Edit Dashboard. 
 

 
 

3. Give the existing tabbed page a more meaningful name. 
Click the Tools button and select Dashboard Properties. 
 

 
 

The Dashboard Properties dialog box appears. 
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4. Select on the “page 1” and Click Rename icon (  ).The Rename dialog box appears. 
 

 
 

5. Enter  PO Summary in the Name text box and click OK. 
 

 
 
6. The Dashboard Properties dialog box reappears with the new dashboard page name. 

 

 
 

7. Click on Edit icon for Dashboard Report Links and set all the report links at the dashboard level. 
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8. Select the check boxes as indicated in the image below: 
 

 
 

9. Click OK and then click OK again to return to the Dashboard Builder. 
The Dashboard Builder should look like this: 

 

 
 

10.  Click the Add Dashboard Page icon (  ). The Add Dashboard Page dialog box appears. 
Name the dashboard page Purchase Order Details and click OK. 
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11. New page appears as follows: 
 

 
 

12. In the Catalog pane, navigate to My Folders/Training and Select PO Prompt and Purchase Order Details analysis 
and drag it to the Page Layout pane on the right. 
 

 
 

13. Edit the properties of the column. Click the Column Properties icon of the Column. 
 

 
 
14. The Column Properties dialog box appears. 
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15. Select the drop-down list for Background Color within the Cell area and choose light green. Click OK, then 
click OK again to close the Column Properties dialog box. 
 

 
 

16.  Click Preview to preview the dashboard. After previewing close the Window. 
 

 
 

17. Save the Dashboard. 
 

18.  You will rename the section. Click Properties (within the section) > Rename. The Rename dialog box appears. 
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19. Enter Detail Report in the text box. 

 
Click OK. 

 
20. Click Properties (within the section) > Show Section Title. 

 
 

21. Preview the dashboard page once again to see your changes. 
 

 
Deta 

22. Save the Dashboard. 
 

23. Override the default dashboard report links at the analysis level. 
Click the Properties icon for the Purchase Order Details analysis, and select Report Links. 
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The Report Links dialog box appears. 
 

 
 

Select the Customize radio button and then select all check boxes. 

 
Click OK. 

 
24. Save and run the dashboard page. You are now able to export and copy this analysis from the dashboard. 
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9.4 Save a Dashboard Customization 

 
To save a dashboard Customization and set preferences, perform the following steps: 
Create a personal, customized view of your dashboard page. Saved customizations allow you to save and view dashboard 
pages in their current state with your most frequently used or favorite choices for items such as filters, prompts, column 
sorts, drills in analyses, and section expansion and collapse. By saving customizations, you do not need to make these 
choices manually each time that you access the dashboard page. 

 

 

1. Click on PO Summary Page on My Dashboard and Leave PO Business Unit as DOTM1. 
 

 
 

2. Click Page Options > Save Current Customizations. 
 

 
 
 
 
 
 

3. The Save Current Customization dialog box appears. Name your customization DOTM1 and click OK. 
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4. Next change the Business Unit Filter to DOCM1 and click Apply. 

 

 
 

5. Click Page Options > Save Current Customizations and name the Customization as DOCM1. 
 

 

 
 

6. Your Saved Customization should appear as follows:- 
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Now you can apply the saved customization to a dashboard page.  
 

7. Click Page Options > Apply Saved Customization > DOTM1. And the Dashboard will run for the saved filters 
under this customization. 
 

 
 

8. Now go to page option and click on Apply Saved Customization to see that DOTM1  is bold. Which means that 
this customization is what is displayed on dashboard. 
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9. Customizations can be deleted from Edit Saved Customization. Click Page Options > Edit Saved 
Customizations  

 
 

10. Click OK to close the Edit Saved Customization. 
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9.5 Set Preference 
 

Set your preferences. You use the Preferences tabbed page in the My Account dialog box to specify your personal 
preferences, such as dashboard starting page, locale, and time zone. The available options depend upon your privileges. 
 

 

1. Click your User ID on the global header and then select My Account. 
 

 
 

The My Account dialog box appears. 
 

 
 

2.  Click the Starting Page drop-down list and scroll to view the available pages. Only the dashboard pages to 
which you have privileges appear in this list. Select the My Dashboard as your default. 

 
Other tabbed pages in the My Account dialog box include the following: 

 

 BI Publisher Preferences—Use this tabbed page to view the default profile for BI Publisher. 

 Delivery Options—Use this tabbed page to configure your delivery profiles for the delivery of 
alerts by agents. 

 Roles and Catalog Groups—Use this tabbed page to view a list of the roles to which you have 
been assigned by the OBI Administrator. 

 
3. Set the Locale, User Interface Language, Time Zone, Currency, and Accessibility Mode appropriately for your 

own needs and click OK. 
 

Note: The Analysis Editor drop-down is a new feature in the current release. 
 

4.  Click OK. 
 
5. To verify that your starting page is now set to the My Dashboard page, log out and log back in. Your start page 

would be your My Dashboard. 
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9.6 Export the Dashboard to Excel Spreadsheet 
 

You can export an entire dashboard or a single dashboard page to Microsoft Excel 2007+. 
 
Note: - If there are more than 100 rows then scroll down to the analysis and click on double sided arrow, so that it displays all the rows 
and now we can export the analysis. 

 

 

 

1. Click Page Options > Export to Excel to select Export Current Page. 
 

 
 

Note: - If you choose Export Entire Dashboard then all dashboard pages of My Dashboard are exported to excel 2007. But 
make sure that in all pages the double sided arrow is clicked so that all the rows will be downloaded. 

 
2. Choose Export Current Page and following window will pop up. 

 

 
 

Click OK to see the dashboard page on the Excel. 
 
 
 
 
 
 
 
 

10. Agents 
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Introduction Agents enable you to automate your business processes. You can use them to provide 
event-driven alerting, scheduled content publishing, and conditional event-driven action 
execution. Agents can dynamically detect information-based problems and 
opportunities, determine the appropriate individuals to notify, and deliver information 
to them through a wide range of devices (email, phone, and so on). 

Objectives At the end of this section, you will be able to complete the following tasks related to 
agents. 

 Understand Agents 

 Create Agents 

 Verify the Mail Client for the Agent/Alerts 
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10.1 Understand Agents 
 

In the simplest format, an agent automatically performs a specified catalog analysis based on a defined schedule, and 
examines the results for a specific problem or opportunity. If the specific problem or opportunity is detected in the 
results, an alert is generated and delivered to specified recipients and to subscribers to the agent, using the delivery 
options that are specified for each person. 
 

 
 

1. Click on New > then Agents from Global Header. 
 

 
 

2. The following are the contents of Agents. 

Guided Exercise 
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Contents Description 

1. General General tab to specify the priority of the agent and how to send the delivery content. 
 

 
2. Schedule Schedule tab and verify that scheduling is enabled, Frequency is set to Once, and the 

Start date and time are set to the current date and time. 

 
3. Condition Condition tab, select the Use a condition option and click Create. The Create 

Condition dialog box appears. 

 
4. Delivery Content Delivery Content tab to identify the content that will be delivered by the agent. 
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5. Recipients Recipients tab, select the default option to identify the recipients of the agent.  

 
6. Destinations Destinations tab, select the destination for the agent. 

 
7. Actions Action tab, specifies any actions to invoke when the Agent completes. 
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10.2 Create Agents 
 

  This topic covers how to create an alert/agent based on a condition and how to define the destination for both the 
dashboard and the email Client. 

 

  
  

1. Click New in the Global Header and select Agent to navigate to the Agent Editor. 
 

 
 

2. Agent Editor opens. 
 

 
 
 

3. On General tab, select the following options: 
 

a. Priority Normal 

Guided Exercise 
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b. Run as Specified user 
 

                  
 

4. Click the Schedule tab and verify that scheduling is enabled. Frequency is set to Once, and the start date and 
time are set to the current date and time. 
Disable Re-run Ageng Every as diabled. 
 

                          
 

5. Click Delivery Content tab and enter the following: 
 

a. Enter a Subject Name Alert - Count of PO’s by Item ID 
b. Select Analysis from the Content drop-down list and click Browse to select the analysis. 
c. Select Count of PO’s by Item ID Report from the My Folders/Training folder in Catalog. 
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d. Change the Format to Excel 2003 from the Format drop-down list. 
 

 
 

6. Click on Recipients tab, and click on Add User Email Recipient icon  to add your email id. 
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7. Enter Email Address dialog opens where we can enter multiple Email address by separating with commas. 
Please enter your email id and click OK. 
 

 
 

8. Leave all the default, the Recipients screen will appear as follows: 
 

 
 
 
 
 

9. On the Destinations tab, select the destination for the agent. 
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For User Destinations, select the Home Page and Dashboard check boxes. Select the Devices check box and 
enable Active Delivery Profile. 
 

 
 

10. Click the Save button  to save the agent. In the Save Agent dialog box, save the agent as Alert – Agent 
Summary in the My Folders/Training folder. 
 

 
 

 
 

11. Click the Run Agent Now button. Verify that the agent is running in the Running Agent dialog box:  
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When the agent has run successfully, you should receive a confirmation: 
 

 

 
 
Click OK. 
 
Verify that the agent ran successfully and generated alerts in the expected locations. These locations are 
Home Page and Dashboard, and the email Client. 
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10.3 Verify the Mail Client for the Agent/Alert 
 

In this topic, you verify the alerts generated by the agent that you created. The alerts appear on the Dashboard and the 
email client as well. 

 
1. Navigate to the Home page. There is an alert in the Global Header. 

 

 
 

  Click the Alerts link in the Global Header to view the alert. 
 

2. Navigate to My Dashboard and verify that the alert appears. 
 

 
 

3. Click on Alert – Count of PO by Item ID action link to see the results run by the agent. 
 

 
 

 



Copyright © 2002-2016 State of Connecticut ToC Page | 169 

 

 
 
 

      
 

4. You can click the Alerts link in the Global Header to view the alert from Global Header where you can Edit, Delete 
or Run Again. 
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Note:- By clicking on Clear All will delete all the Alerts. And even the alert will disappear from the Home and 
Dashboard Page. 

 
5. Click OK to close the alert. 
6. Open your Client Email (Outlook) to check for the alert emails. 

 

 
 

You see the messages sent by OBI for the alert/agent that you created. 
 

7. Double-click the alert message to open it. The message is displayed with the details that you entered while 
creating the agent. The analysis is delivered as an attachment. 

 

 

 
 

   Click the attached report to open it. 
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  This concludes the topic of sending alerts through OBI Delivers. 

 


